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About Steve Smiley
Band Director
Programmer (EDS, RadioShack, HCP)
Webmaster
Adjunct Instructor for ESC XI
Soccer Coach
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Who are you?
Name

Teaching Field

Favorite Eating Implement (knife, fork, spoon)
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Schedule
Pre-Workshop – Story Boards and Site Design

January 14/15 – Overview and Adobe Photoshop

January 28/29 – Macromedia Flash

February 11/12 – Macromedia Freehand

February 25/26 – Macromedia Dreamweaver
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Internet and Web Design
NOT complicated
Must be concerned with:

The user
What they want
How to get it easily
Presentation

The owner
Intended Purpose
Maintenance

Image provided by Lumeta Corporation (http://www.lumeta.com)

The Internet is made up of 15-20 simple technologies.  It seems complicated 
because of the flexibility and extensive use of these technologies.  Topologies, 
structures that grow in complexity exponentially, are an excellent example of a 
complex structure such as the Internet.  A complex topology consists of an infinite 
level of simple curves and lines connected into increasingly complex angles and 
edges.  

A web page, or site, is equivalent of the complex topology’s lines and curves.  Each 
web page and site should have a defined structure and organization based on:
•The information contained within the site or page
•The developer’s goals in presenting the information
•And the long-term intent of the site.
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Information Design
Message – What do you want to say
Audience – Who are you trying to reach
Purpose – What do you want them to do with it
Background – Why you are here
Structure – How it is organized

Information is defined as the stuff on a page.  Usually there is an innate 
organization to this “stuff”.

Does the information to be contained on a site have a hierarchy, I.e. some concepts 
and ideas are more important or critical than others?
Can the information be organized into equal junks in importance?
Must the information be displayed in a “building block” fashion, I.e. concept #1 
must be learned before concept #2 before concept #3?

How the information you intend to display can be organized determines what type 
of web page or site you will create.
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Navigation Schemes
Linear Structure

1, 2, 3, 4, etc.  

Linear Structure Examples:
•Powerpoint Presentations
•The chapters in a book
•Directions for building a house
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Navigation Schemes
Linear Structure

1, 2, 3, 4, etc.  

Hierarchical Structure
Most common
DB and information design

Hierarchical Structure Examples:
•Business/School Organizations
•Most school subjects

•History
•War of 1812

•Generals
•World War II

•Generals
•Vietnam War

•Generals
•Physical Science subjects
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Navigation Schemes
Linear Structure

1, 2, 3, 4, etc.  

Hierarchical Structure
Most common
DB and information design

Random
Everything is = to everything

Random Structure Examples:
•Definition of parts of a sentence
•Marble collection
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Navigation Schemes
Linear Structure

1, 2, 3, 4, etc.  

Hierarchical Structure
Most common
DB and information design

Random
Everything is = to everything

Mixed
Contains two or more structures

Most sites are a collection of each of these elements.

For example, click around the Adobe site (http://www.adobe.com)
It was created with a hierarchy in mind, but the tutorials are organized in linear 
fashion.  The dictionary attached to the tutorials can be used as a hierarchical 
structure or random structure, depending on if the search is used.

This site is a good (not great, but good) example of the different structure.



11

Technology Training
January-February 2003

Presentation Design
Navigation – determined by information type
Color Scheme – contrast and usage
Font Selection – standard versus enhanced
Graphics Selection – appropriate to subject
Multimedia Effects – good and bad
Layout – where is everything

English/International/Cultural 

How you want your page to look is partially determined by the information that you 
are trying to display.  However, there are as many ways to create a page as there are 
people creating pages!

Basic areas to include:
A top logo region

Show the owner/creator and the basic intent of the site
A top or left navigation area

Displays the available information on the site and allows the user a 
way to access it

A “body” area where most content and information is displayed

Optional parts:
A top navigation area that contains important, but not critical, links to other 
functions, such as contacts, help, etc.
A bottom bar that contains copyrights and direct contact information
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Before you create…..you need
A storyboard image or graphic
Element list

Navigation
Pictures
Page List or overview
Content blocks

An audience checklist
Development and Maintenance Timeline

Inspiration 6.0 is one way to develop a visual representation of your page or site.  
Most people have an easier time working with a visual view of a page than a written 
narrative.  

Pencil and paper still work, even in the 21st century!  Create a drawing of your page 
and site structure.  This will be the equivalent of the mental map that you are asking 
your viewers to build as they click through your site.  If you don’t understand the 
structure of your creation, don’t expect your site visitors to understand it either

SIMPLIFY, SIMPLIFY, SIMPLIFY!
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PhotoShop General Concepts
Layer-based graphics development tool
Vector or Raster (Bitmap) formats
PSD is the default save configuration

Remembers all editing information
Large
NOT portable

Current Version 7.0

Layers are a holdover from several areas – printing, architecture, and, most 
importantly, painting/drawing.  

IN oil painting, the colors that are seen in the finished painting are layers of 
multiple colors, blended and dried at different times.  This concept is as old as 
painting.  In Photoshop, layers are physical elements of a digital graphic that allow 
you to separate and control individual parts of a graphic – applying blends, colors, 
and transforms to single parts without destroying the overall effect.

Remember that PSD, Photoshop’s default format, is not a finished element.  It is not 
portable or viewable on the web.  PSD is used to preserve the image during its 
development and allow for easy maintenance after web or print ready images are 
created from the PSD.
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Graphics Formats
Vector Formats

Composed of mathematical instructions for drawing the image
Highly-scalable with no distortion
Examples: 

Direct Vector: CDR, EPS, PCT, WMF
Combination Vector/Raster: PSD, PNG, TIF

Raster (Bitmap) Formats
Pixel-based (size of pixel determined at creation)
Direct Raster: GIF, JPG, BMP

Raster formats are the most common on the Internet.  They are not scalable and are 
designed to reproduce in a “good enough” fashion.  

Photoshop has some restrictions on using raster and vector images:
The background of a raster image CONTAINS the image.  Background is not 
separate from image in the raster format.
Shapes created within Photoshop are, by default, vector elements.  Problem, they 
cannot be integrated into a layer and transformed until they are turned into raster 
elements.
Anti-aliasing is possible in both formats, but it is considered part of the background 
in raster images, and part of the anti-aliased element in vector images.
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Photoshop Walkthrough



16

Technology Training
January-February 2003

ToolBox
Contains all of the tools needed to create images

Top section – Image manipulation
Middle section #1 – Drawing and color tools
Middle section #2 - Text and scribbling tools
Bottom section – notation and collection tools
Active color section
Options and external applications section

The major rule in Photoshop is:

DON’T FORGET TO CHANGE TOOLS!
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Tool Options Bar

Options bar changes based on the selected tool from the toolbox

Feathering – the smoothness or hardness of an object’s edge
Tolerance – the number of colors relative to the selected color
Aliasing – feathering around individual elements or fonts
Presets – a set of options pre-configured for a tool
Modes – blending, overlays, exclusions
Opacity – the transparency of a selected object

The Toolbar Options selections are different for every tool selected in the toolbox.

One option for learning ALL of the options available is to go through the toolbar, 
selecting each tool, and changing each of the options that appear on the tool options 
bar.  

Definitions for the most common terms are contained on the slide.
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Navigator Window
Shows the image in its 
completed form
When zoomed, image can 
be navigated through this 
window with the mouse
Info tab shows image 
options at present and 
cursor location

The navigator window shows you what you can see.  

Open an image and zoom in using the Ctrl-+ key.  The red box in the navigator 
window will show you which portion of an image you are viewing.

This tool is very useful when you are using painting tools, zoomed in so that you 
can affect single pixels.
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Color
Allows for direct selection 
of color in multiple modes
Shows the current 
foreground and 
background selections
Can output numerical 
values in multiple color 
palettes

The color tab allows for the control of color using slider bars and numerical 
selections.  It can control the color for the creation of new shapes, or control the 
changes in color during a Free Transform or Transform operation.

Remember that the colors as applied to the image are controlled by the color palette 
associated with the image, I.e. new images created using the CMYK palette will 
have a different set of colors than an RGB image.
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Color Palettes
Final usage of image determines the best color 
palette to use

Grayscale – 256 levels of gray (white to black)
Indexed – 256 color mode using a CLUT
CMYK – Cyan, Magenta, Yellow, Black (print)
RGB – Red, Green, Blue (screen)
Web (safe) – limited 256 palette which is recognized by 
older browsers 

Colors associated with an image can be changed using the Image | Mode menu 
selection.  Also, the “strength” of a color (luminosity, hue, saturation) can be 
controlled from the Image | Adjustments menu selection.

Existing colors, such as in a grey scale image, are not affected by the color model 
selected from the menu.  Example: the Ranch House.jpg in the Adobe | Samples 
directory is grey scale.  If you select any other mode from the Images | Mode menu 
selection, the existing image is still grey scale.  However, additions to the image 
will use the newly selected color mode. 
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Swatches
Simplified version of the 
color tab
Shows the basic set of 
colors available within a 
color model
NOT flexible

With ease of use comes lack of flexibility.  This is a quick and easy way to select 
colors.  As a general practice, use the Color tab.  
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Styles
Preset selection of styles 
that can be applied to a 
selection
Easy way to import and 
apply textures
Used to create buttons
Can be expanded with 
your own styles

You can select other textures/styles/colors by clicking on the black triangle in the 
upper right corner of this window.  The displayed menu allows to to import styles 
that you have created or downloaded.  Available styles are shown at the bottom of 
the menu.  There are thousands of available styles for Adobe Photoshop on the 
internet.

The Adobe Studio (http://share.studio.adobe.com/Default.asp) has a large number of 
styles that can be downloaded and used immediately.

The simplest uses for styles are:
• The creation of a default button image
• The application of a texture to all or part of an image
• The use of a consistent style across multiple images



23

Technology Training
January-February 2003

History
For beginners, the most 
important tab!
Allows rollback to any 
previous state during an 
editing session.
If you do something 
dumb, click on the history 
tab at the point before you 
did it!

Do NOT confuse the History and Layer tabs.  This was a problem during class.
Note the following guidelines when using the History palette:
•Program-wide changes, such as changes to palettes, color settings, actions, and 
preferences, are not changes to a particular image and so are not added to the 
History palette. 
•By default, the History palette lists the previous 20 states. 
•Once you close and reopen the document, all states and snapshots from the last 
working session are cleared from the palette. 
•By default, a snapshot of the initial state of the document is displayed at the top of 
the palette. 
•States are added from the top down.. 
•Each is listed with the name of the tool/ command used to change the image. 
•By default, selecting a state dims those below. By default, selecting a state and 
then changing the image eliminates all states that come after. 
•If you select a state and then change the image, eliminating the states that came 
after, you can use the Undo command to undo the last change and restore the 
eliminated states. 
•By default, deleting a state deletes that state and those that came after it. 
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Layers
Shows which layers are visible
Controls the order in which 
layers are displayed
Shows the effects which have 
been applied to a layer
Allows for detailed control of 
which parts of an image are 
visible within a composition.
Hardest part of Photoshop to 
master.

The Layers palette lists all layers, layer sets, and layer effects in an image. You can 
accomplish many tasks--such as creating, hiding, displaying, copying, and deleting 
layers--using the buttons in the Layers palette. You can access additional commands 
and options in the Layers palette menu and the Layers menu.

You can access the layers menu either from the menu at the top of Photoshop or by 
clicking on the black triangle at the upper right corner of the layers window.
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Selection Tools

Selection is one of the most important 
aspects of Photoshop
If you can select, you can create images that capture 
attention and highlight your point.
More than 75% of your work in Photoshop with existing 
images consists of selection and placement activities
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Special Keyboard Keys
Alt-key – generally used to subtract from a selection
Shift-key – generally used to add to a selection
Ctrl-key – usage varies depending on the selection tool 
used

The status bar at the bottom of Photoshop describes what 
keyboard enhancements are available for a specific 
selection tool.

Remember that each tool has a different set of alternate actions for these keys.  
Always check the Photoshop status bar at the bottom of the image window to 
determine what keys you can use and for what purpose.
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Marquee
Used to constrain and 
select an area.
Types: 

Rectangle 
Ellipsis
Single Row
Single Column

To use the marquee tools:
1. Select a marquee tool: Rectangle marquee to make a rectangular 

selection, Elliptical marquee to make an elliptical selection, or Single 
row or single column marquee to define the border as a 1-pixel-wide row 
or column. 

2. In the options bar, specify whether to add a new selection, add to a 
selection, subtract from a selection, or select an area intersected by other 
selections  . 

3. Specify a feathering setting in the options bar. Turn anti-aliasing on or 
off for the rounded rectangle or elliptical marquee. 

4. For the rectangle, rounded rectangle, or elliptical marquee, choose a 
style in the options bar: 

5. For aligning your selection to guides, a grid, slices, or document bounds, 
Choose View > Snap, or choose View > Snap To and choose a command 
from the submenu. The marquee selection can snap to a document bound 
and more than one Photoshop Extra..

6. Make a selection by dragging over and area and using the alternate keys 
to add or subtract from your selection. 

7. To reposition a rectangle, rounded rectangle, or elliptical marquee, first 
drag to create the border, keeping the mouse button depressed. 
Then hold down the spacebar and continue to drag. If you have finished 
drawing the border, drag from inside the selection.
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Slice
Slices are used to save a 
single image in multiple 
pieces
Not used from Photoshop 
a great deal
Eases the creation of 
background images in web 
pages that cross textual or 
perceptual boundaries.
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Crop
Used to remove extraneous sections of a picture 
or image
Select one corner and drag to the opposite corner
Once the specified area is highlighted, hit Enter.
The canvas automatically resizes to the selected 
area.
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Lasso
Important Tool!

Three types:
Lasso

freehand selection of an area
Polygonal Lasso

“connect-the-dots” selection
Magnetic Lasso Tool

Relative to previous color 
selection

Using the lasso, polygonal lasso, and magnetic lasso tools
The lasso and polygonal lasso tools let you draw both straight-edged and 

freehand segments of a selection border. With the magnetic lasso tool 
(Photoshop), the border snaps to the edges of defined areas in the image. 

The magnetic lasso tool is especially useful for quickly selecting objects 
with complex edges set against high-contrast backgrounds.

Lasso is a freehand tool.
The polygonal lasso tool uses points that are created by clicking the mouse to create 

points and angles.
The magnetic lasso tool traces edges of a similar color.  The color used for 

the next point is based on the points traveled by the mouse.  
To bail out, hit ESC.
To end a selection, hit ENTER.
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Lasso Sample

Originals

After Lasso and Combine
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Magic Wand
Another important tool!

lets you select a consistently colored area (for example, 
a red flower) without having to trace its outline
Uses a color “tolerance”, a variance from the initially 
selected color, to determine what is selected.

Using the magic wand tool
Note: You cannot use the magic wand tool on an image in Bitmap mode.

To use the magic wand tool:
1. Select the magic wand tool  . 
2. In the options bar, specify whether to add a new selection, add to an 

existing selection, subtract from a selection, or select an area intersected 
by other selections  . The magic wand cursor changes depending on 
which option is selected. 

3. For Tolerance, enter a value in pixels, ranging from 0 to 255. Enter a low 
value to select colors very similar to the pixel you click, or enter a higher 
value to select a broader range of colors. 

4. To define a smooth edge, select Anti-aliased. 
5. To select only adjacent areas using the same colors, select Contiguous. 

Otherwise, all pixels using the same colors will be selected. 
6. To select colors using data from all the visible layers, select Use All 

Layers. Otherwise, the magic wand tool selects colors from the active 
layer only. 

7. In the image, click the color you want to select. If Contiguous is 
selected, all adjacent pixels within the tolerance range are selected. 
Otherwise, all pixels in the tolerance range are selected.
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Clone Stamp
Allows for the selection of 
a single offset from the 
cursor
Will paint whatever is that 
distance from the cursor 
under the cursor
Can transfer a portion of a 
picture EXACTLY to 
another portion

Using the clone stamp tool
1. Select the clone stamp tool  , and do the following in the options bar: 

• Choose a brush and set brush options. 
• Specify a blending mode, opacity, and flow. 
• Determine how you want to align the sampled pixels. If you 

select Aligned, you can release the mouse button without losing 
the current sampling point. As a result, the sampled pixels are 
applied continuously, no matter how many times you stop and 
resume painting. If you deselect Aligned, the sampled pixels are
applied from the initial sampling point each time you stop and 
resume painting. 

• Select Use All Layers to sample data from all visible layers; 
deselect Use All Layers to sample only from the active layer.

2. Set the sampling point by positioning the pointer in any open image and 
Alt-clicking (Windows) or Option-clicking (Mac OS). 

3. Note: If you are sampling from one image and applying to another, both 
images must be in the same color mode.

3. Drag in the image. 
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Transforms
An action that can be taken on a 
selection
Two Types:

Free Transform
Creates a bounding box to modify the 
selection

Transform Menu
Scale
Rotate/Flip
Skew
Distort
Perspective

Transforms in Photoshop are defined as any manipulation of the image beyond 
drawing or color changes.

You can transform:
•Entire canvas
•Entire layers
•Selections
•Pastes into an image
•Shapes (once rastered)

Remember that the selection box around any transformed object will contain circle 
points at the midpoints and corners until the transform is “committed” by hitting the 
ENTER key or responding to an Adobe pop-up box.



35

Technology Training
January-February 2003

Mushroom Man
Mushroom Man Exercise

Create a mushroom person 
and attendants using the 
provided pieces
Emphasis on:

Selection
Transforms

Time: 30 minutes
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Drawing Tools
Patch Tool
Pencil/Pen
Clone/Stamp
Art History/History Brush
Eraser
Paint Bucket
Smudge/Blur/Sharpen
Dodge/Burn/Sponge

Using the paint tools is a series of easy decisions:
1. Specify a foreground and background colors.
2. Select the brush tool or pencil tool  . 
3. Do the following in the options bar: 

• Choose a brush and set brush options.
• Specify a blending mode.
• Specify an opacity.
• For the brush tool, specify a flow rate 
• Drag in the image to paint. 

TRICKS:
• Click the airbrush button   to use the brush as an airbrush. Alternately, select the 

Airbrush option in the Brushes palette. 
• For the pencil tool, select Auto Erase to paint the background color over areas 

containing the foreground color. 
• To draw a straight line, click a starting point in the image. Then hold down Shift, and 

click an ending point. 
• When using the brush tool as an airbrush, hold down the mouse button without 

dragging to build up color.
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Shapes and Fills 
Shapes have a set of 
options for each type
Be careful:  A shape and a 
marquee are not the same 
thing!

Setting shape tool options
1. Pick a shape tool. 
2. Set tool options in the options bar. The available options vary by tool. In Photoshop, 

click the inverted arrow   next to the shape buttons to view the options: 
• Arrowheads Start and End - Renders a line with arrowheads. Note: In Photoshop, 

you can also edit an arrowhead directly using the vector selection and drawing tools.
• Circle - Constrains an ellipse to a circle.
• Defined Proportions - Renders a custom shape based on the created proportions.
• Defined Size - Renders a custom shape based on the size at which it was created.
• Fixed Size - Creates a fixed shape based on the values in the Width and Height text 

boxes.
• From Center – Creates the selected shape from the center.
• Indent Sides By - Renders a polygon as a star. 
• Proportional - Creates shape proportional, based on values entered in Width/ Height 

boxes.
• Radius - Rounded rectangles = the corner radius. Polygons = distance from the center 

of a polygon to the outer points.
• Sides - Specifies the number of sides in a polygon.
• Smooth Corners or Smooth Indents  - Renders a polygon with smooth corners 

or indents.
• Snap to Pixels - Snaps rectangle or rounded rectangle to the pixel boundaries.
• Square - Constrains a rectangle or rounded rectangle to a square.
• Unconstrained - Sets the width and height of a selected shape by dragging.
• Weight - Determines the width of a line in pixels.
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Shapes and Fills - Options

Object Type (Layer, Paths, Fill)
Object Shape
Mode (Color and exclusion)
Opacity
Aliasing 

Remember that opacity and aliasing must be taken into account when creating 
shapes, BEFORE the shape is drawn.  The History tab allows for the easy deletion 
of mis-created shapes, but it is always less trouble to create it as desired the first 
time.
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House and Cars
Build your own house 
using:

Lines
Shapes
Fill
Layers

Time: 10 minutes
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Font

One complete collection of letters, punctuation marks, numbers, 
and special characters with a consistent and identifiable typeface, 
weight, posture, and size.

Computer & Internet Dictionary (©1995)
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Adding Type
When you create type, a new type 

layer is added to the Layers 
palette. In Photoshop, you 
can also create a selection 
border in the shape of the 
type. 

Note: In Photoshop, a type layer is not 
created for images in Multichannel, 
Bitmap, or Indexed Color mode, 
because these modes do not support 
layers. In these image modes, type 
appears on the background.

To commit changes to a type layer:
Do one of the following:
•Click the Commit button   in the options bar. 
•Press the Enter key on the numeric keypad. 
•Press Ctrl+Enter on the keyboard (Windows) or Command+Return (Mac OS). 
•Select any tool in the toolbox, click in the Layers, Channels, Paths, Actions, 
History, or Styles palette, or select any available menu command.
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Type Tool
An insertion point is 
created when the type tool 
is selected.
The Character Window 
controls the font, color, 
weight, and orientation of 
a single font creation.

Once you create a type layer, you can edit the type and apply layer commands to it. 
You can change the orientation of the type, apply anti-aliasing, convert between 
point type and paragraph type, create a work path from type, or convert type to 
shapes. You can move, restack, copy, and change the layer options of a type layer as 
you do for a normal layer. You can also make the following changes to a type layer 
and still edit the type:
•Apply transformation commands from the Edit menu, except for Perspective and 
Distort. (To apply the Perspective or Distort commands, or to transform part of the 
type layer, you must rasterize the type layer, making the type uneditable.) 
•Use layer styles. 
•Use fill shortcuts. To fill with the foreground color, press Alt+Backspace 
(Windows) or Option+Delete (Mac OS); to fill with the background color, press 
Ctrl+Backspace (Windows) or Command+Delete (Mac OS). 
•Warp type to conform to a variety of shapes.
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Adding Paragraphs
The Paragraph Window 
controls how the text is 
carried within the insertion 
box.
Options:

Alignment
Margins
Leader/Trailer
Hyphenation

To enter paragraph type:
1. Select the horizontal or vertical type tool  . 
2. Do one of the following: 

• Drag diagonally to define a bounding box for the type. 
• Hold down Alt (Windows) or Option (Mac OS) as you click or 

drag to display the Text Box Size dialog box. Enter values for 
Width and Height, and click OK.

3. Select additional type options in the options bar, Character palette, 
Paragraph palette, and Layer > Type submenu. 

4. Enter the characters you want. Press Enter on the main keyboard 
(Windows) or Return (Mac OS) to begin a new paragraph. If you enter 
more type than can fit in the bounding box, the overflow icon   appears 
on the bounding box. 

5. If desired, resize, rotate, or skew the bounding box. 
6. (Photoshop) Commit the type layer. 
7. The type you entered appears in a new type layer.
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Text Layers
For a successful text layer:

Ensure that the image is 
NOT in indexed mode.
Move the created text layer 
to the top of the layer 
window so that it is visible.
Lock layers where the text 
should never be placed.

Text is created in a special container called a Type Layer.  To work with these 
layers as an integrated part of an image, do the following:

To convert a type layer to a normal layer:
1. Select the type layer in the Layers palette. 
2. Choose Layer > Rasterize > Type.

Once the type has been rasterized, it can be manipulated as an object on an image 
without causing changes to text width, height, or spacing.  

Note: Before converting a text layer, ensure that all transforms or changes needed 
have been completed.  Rasterized text layers are not editable; only transforms 
can be applied to the layer.
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Add Text to The Harvest
Open Adobe/samples/harvest.psd
Add banner text of your choosing
Use the free transform tools to 
experiment
Experiment with colors, layer usage, 
and placement

Time: 10 minutes
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Blending
Remember:

Some tools have individual blending options
Blending is NOT an exact science

Blending
base color + applied color = resulting color

(All color elements can define a single color)

Blending Mode Definitions
•The base color is the original color in the image. 
•The blend color is the color being applied with the painting or editing tool. 
•The result color is the color resulting from the blend.

Normal: Edits or paints each pixel to make it the result color. *default
Dissolve: Edits/paints pixels to make it the result color. Result color is a random 
replacement of pixels with base color or blend color, depending on a pixel’s opacity. 
Behind: Edits or paints only on the transparent part of a layer. (layers with Lock 
Transparency deselected) 
Clear: Edits or paints each pixel and makes it transparent. 
Darken: Selects the base or blend color--whichever is darker--as the result color. 
Multiply: Multiplies the base color by the blend color. The result color is always a darker 
color. 
Color Burn:  Darkens the base color to reflect the blend color by increasing the contrast. 
Blend with white = no change.
Linear Burn: Darkens the base color to reflect the blend color by decreasing the 
brightness. Blend with white = no change.
Lighten: Selects the base or blend color--whichever is lighter--as the result color. 
Screen: Multiplies the inverse of the blend and base colors. The result color is always a 
lighter color. Black = no change.
Color Dodge: Brightens the base color to reflect the blend color by decreasing the contrast. 
Black = no change.
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Layer Blending
Available to all unlocked 
layers
Effects can be applied to 
individual layers or 
duplicated across all layers
Used to enhance/reduce 
the importance of a layer

Blending Mode Definitions (Continued)
Linear Dodge: Brightens the base color to reflect the blend color by increasing the brightness. Black 
= no change.
Overlay: Multiplies or screens the colors, depending on the base color. 
Soft Light: Darkens or lightens the colors, depending on the blend color. (soft) 
Hard Light: Multiplies or screens the colors, depending on the blend color. (hard) 
Vivid Light: Burns or dodges the colors by increasing or decreasing the contrast, depending on the 
blend color. 
Linear Light: Burns or dodges the colors by decreasing or increasing the brightness, depending on 
the blend color. 
Pin Light: Replaces the colors, depending on the blend color. 
Difference: Subtracts either the blend color from the base color or the base color from the blend 
color, depending on which has the greater brightness value. white = inverse; Black = no change. 
Exclusion: Creates an effect similar to but lower in contrast than the Difference mode. white = 
inverse; Black = no change. Hue: Creates a result color with the luminance and saturation of the 
base color and the hue of the blend color. 
Saturation: Creates a result color with the luminance and hue of the base color and the saturation of 
the blend color. 
Color: Creates a result color with the luminance of the base color and the hue and saturation of the 
blend color.
Luminosity: Creates a result color with the hue and saturation of the base color and the luminance of 
the blend color. 
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Layer Blending Sample

Before blending
After blending

Stroke and Drop Shadow
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Web File Types
GIF

Excellent choice for line-based images, such as 
navigation graphics or clip art 
Color table range from 2 (1-bit) to maximum of 256 
colors (8-bit) 
Pixel-by-pixel representation of an image - usually 
larger in size than other formats 
Supports a transparency color and a range of colors 
around the designated "transparent" color 
No built-in image compression 
Compression available only within color table; image 
not affected from original
Supports multiple images in one file (animated gifs) 
Supports interlaced images for faster display 
(incomplete image starts to display before complete 
file is downloaded) 

JPG
Excellent for full color images 
Color table size always supports 16.7 million colors 
(24-bit) 
Uses several algorithms to compress images into 
smallest size
Cannot contain a "transparent" color 
Range of compression from 0 to 100% 
Higher compression ratios = lower image quality 
One file = one image 
Linear images only

To save a file in GIF format:
1. Save the artwork, and choose CompuServe GIF from the Format menu. 
2. For RGB images, the Indexed Color dialog box appears. Specify conversion options and click 

OK. 
3. Select a row order for the GIF file, and click OK: 
• Normal displays the image in a browser only when download is complete. 
• Interlaced displays low-resolution versions of the image in a browser as the file downloads. 

Interlacing makes download time seem shorter, but it also increases file size.
To save a file in JPEG format:

1. Save the artwork, and choose JPEG from the Format menu. 
2. In the JPEG Options dialog box, select the options you want, and click OK. 

• Matte - If the image contains transparency, select a Matte 
color to simulate the appearance of background 
transparency. 

• Image Options - To specify the image quality, choose an option from the Quality 
menu, drag the Quality pop-up slider, or enter a value between 0 and 13 in the Quality 
text box.

• Format Options - Baseline ("Standard") to use a format recognized by most Web 
browsers, Baseline Optimized for optimized color and a slightly smaller file size, 
Progressive to display series of increasingly detailed scans as the image downloads. 
Baseline Optimized and Progressive JPEG images are not supported by all Web 
browsers. 

• Size - To view the estimated download time, select a modem speed. (The Size preview 
is only available when Preview is selected.)

Note: Some applications may not be able to read a CMYK file saved in JPEG format.
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Scanning/Saving/Moving
Scanned images are generally raster images
Bigger is better (>150 dpi)

128MB minimum
Large HDs needed

Save as TIF initially
Then save as PSD before editing (IMPORTANT!)
Once editing is completed, save for web as GIF or JPG

Importing an image using the TWAIN interface 
TWAIN is a cross-platform interface for acquiring images captured by 

certain scanners, digital cameras, and frame grabbers. The manufacturer 
of the TWAIN device must provide a Source Manager and TWAIN Data
source for your device to work with Photoshop and ImageReady. 

You must install the TWAIN device and its software, and restart your 
computer, before you can use it to import images into Photoshop and 
ImageReady. See the documentation provided by your device 
manufacturer for installation information.

To import an image using the TWAIN interface (Photoshop):
Choose File > Import, and choose the device you want to use from the 

submenu.
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Existing Images Pitfalls
Low resolutions - Upsizing causes pixilation

Scan higher if possible
Use Crop to isolate the desired section, then sharpen to enhance
pixilated areas

Scanned text suffers from the jaggies
Use OCR, if available
Scan with lower resolution (<300dpi) to reduce jaggies

ALWAYS SAVE THE ORIGINAL BEFORE EDITING!
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Logo Exercise
Create 3 different versions of the logo:
1. One specific to your discipline and school
2. One that interacts with your favorite eating implement
3. A header image for your future web page that contains:

The logo
Your name (enhanced, of course)
A for your future web page

Use layers, styles, color, fonts, shapes, and transforms.
BE CREATIVE AND EXPLORE THE TOOL!
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Steve Smiley
817-939-5378
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